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software, or usage errors.

In addition to Prota License Agreement Terms, it is the responsibility of
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e tocheck of results generated by documentation and software,

e make sure that the users of the software and their supervisors have
adequate technical capabilities,

e make sure that the software is properly used following the
reference manual and documentation.
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reference manuals and any program component cannot be copied,
distributed, and used in violation of license agreement.
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Introduction

At Prota we are fully committed to providing industry leading, accurate and highly practical structural
BIM modeling, analysis, design, and detailing solutions to the consultancy and engineering industry.

ProtaStructure 2020 is a fantastic new release representing a major milestone in the evolution of our
vision and commitment to you.

ProtaStructure 2020 takes advantage of the latest technology platforms and 64-bit processing and
architecture.

It has been created to provide a more seamless, fluid and optimised experience.

We have carefully redesigned the User Interface from scratch to provide an enhanced user experience
whilst preserving what you know and love about ProtaStructure. We have built on our unique open BIM
platform which allows you to share, communicate and take advantage of the integrated workflows
leading BIM technolgy provides.

We hope you enjoy the many new features, enhancements, and experiences that are awaiting you in
ProtaStructure 2020.

Thank you for choosing ProtaStructure.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Technology and the User Experience

The 64-bit Architecture and Enhanced Technology Platform

At Prota we are continuously investing in the latest technologies to provide you with unique, fit for
purpose structural engineering solutions. ProtaStructure 2020 is now fully compatible with 64 bit
operating systems. We have further optimised this bringing enormous advantages to speed and model
management. This means that you will be able to operate, analyse, design and detail any sized model
faster than ever before.

With ProtaStructure 2020 we have re-engineered our existing technology to a new and more scalable
platform, allowing us to provide you with more improvements, new features, and a fantastic user
experience now and into the future.

A Modern Interface with Fluid User Experience

ProtaStructure 2020 welcomes you with a modern user interface designed from scratch for ease of use
without compromising efficiency.

Our New User Experience Interface - Everything is in its right place

Check out our new fluid ribbon experience blending the familiar with the new. Logically laid out to guide
you though the entire design process — from setout and modelling to seamless BIM collaboration.

Open as many views as you need, including analytical models, reports, 3D rebars, and modeling views.
Views can be organized using smart layout options.
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Detach, Dock or Float the Windows

Customize your work area by docking and floating views. We also considered engineers using multiple
monitors. If you want to make the most of your screenscape, just move one of the views to another
screen.
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Command Search

Type into new ‘Command Search’ function to access mostly used functions just in seconds. The smart
search bar will list the available commands for the current context.

|| Modeling -> Column - RC

[r Modelling - Column - Steel

[-]- Review -> Column Sections

¥] Design -> Celumns - Reinforced
&k Design -> Column Punching Check

=y —l ool

colu
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Search the Structure Tree

Looking for a specific member? Type in the member label in the structure tree’s search box and let
ProtaStructure find it for you.

CORXK
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+ 18235

Contextual Ribbon Tabs

Commands and functions specific to a member type or group of members are now directly accessbile
in the New Contextual Tabs in addition to the right click menu. As soon as you select a member, relevant
commands will appear in dedicated contextual ribbon tabs.

- Column Options
Building Setout Modelling Loading Leview Analysis Design Drawin s Display Views Help Column
—_— 7 Delete l I bﬁ I £ Insert Base Isolator é[ Add Span Load AT Edit Section/Material Insert Column Jacket
= =1 Measure : S Steel Bar Optimisation =+ Add Nodal Load g Edit Materials Steel Corrosion Ratio
Properties Polyline Section Analysis Result Punching
i, Mirror  Column Editor  Design  Diagrams Ched: Steel Realization Ratio
Loading

- Beam Options
IE- Building Seto Modeling Loading Review Analysis Design Drawings & Reports BIM Display Views Help
—_— 7 Delete E] e~ 5 Edit Wall Load 4, Copy Manual Loads 5 Insert Copied Wall by Dragging Beams | Steel Corrosion Ratio
= ki Measure : Tz Copy Wall Load ¥ Delete Manual Loads ~ Deflection/Crack Check Steel Realization Ratio
Properties Section Analysiz Result  Partition Edit Member 8 topy - i
J‘l Mirrar Design Diagrams Wall Loads Loads i Delete Wall Load = [T Paste Copied Beam Loads
Loading

= Slab Options

Building Setout Modelling Loading Review Analysis Design Drawings & Reports BIM Display Views Help

— K Delete = Set Plane Definition of Members ﬁ g‘l ] ..
3 e

Ll Measure 0'? Reset Plane Definition of Members

Properties SetSlab Types  Slab Additional  Point, Line  Define Temperature  Deflection/Crack  Slab Reverse
Automatically Loads and Arealoads  Difference Data Check Deflection Table
Loading

- Rib Slab Options

Building Setout Modelling Loading LEview Analysiz Design Drawings & Reports BIM Digplay

— X Delete ~ Set Plane Definition of Members e v
5 = d =
It Measure 3 Reset Plane Definition of Members — fa—
Properties Set Slab Types  Slab Additional ~ Point, Line  Define Temperature  Deflection/Crack Rib Slab Reverse
Al Mirror Automatically Loads and Area Loads  Difference Data Check Deflection Table
Loading
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Faster Learning Curve: In-Product Learning and Help

We value the time you invest in learning all of whats possible with ProtaStructure. To get most out of
ProtaStructure 2020, we are proud to introduce our new in-product learning tools. You will be onboard
in no time with this faboulous new interactive help, perfect for both those new to Prota or those wanting
to extend their knowledge .

Detailed tooltips with Video Tutorials

Hover over any button and our interactive tooltip appears with useful Descriptions, How To, Tips, and
Short Animations/Videos to guide to seamlessly through the features of ProtaStructure.

PP &
= ||
Project Partiton  Slab Additional
Templates  Wal Loads ads

A Duvar YOkl Kiitiphanes

Wall Loads Library
Edit or append the Wall Load Library

£p Usage

1, Define & new wal load in the library.

2. spedify the reference companents and their
thicknesses

3. Assign these wall loads to Beams using "Edit Wall
Load" feature in the beam right click menu,

4. Assign wall loads on Slabs using Slab Line Loads
feature.

L
120 ®0 oz
230 5o o.105
0 00 0200

Sand I T —
T

y Tip
1. Use "Edit References” feature to change the
reference load types, This wil enable you to quickly @, Ailanasinnds
replace assigned load.
2. As an alternative method for assigning partial or
full kength wall loads, copy any assigned wal load on
a beam, right dlick and select "Define Beam Wall
Load"” commary
3. Pick twa points on any location on the beams.

55 watch
How to use Beam Wal Load Library?

gommEmEpEnNg:

|| x Toglaen Yk (n2): 0333 x ot

Press F1 for more help.

IR _ LN

Contextual links to Prota Help Center

Get instant, relevant information with a key stroke. Whenever you hit F1 on a tooltip or window, you
will be taken directly to relevant knowledge base article in our Prota Help Center, providing direct
information on whats important to you.

e Prota Help Center Home  Knowledge Base  Community ~ New Ticket My Area P
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2 Reports
atersl 1085 wil be isibuted 1 the Iateral 10ad resisting Systems via fioar daphram action Wi
ProtaStrusturs diaphragm modeling is achieved using diaphragm constrains 2 Uuiiding Wodsl Check
A diaphragm constraint il maintain skact ralative postioning of 2l nodes that 1 constrans, | & the 5
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distance between any two nodes constrainad by a disphraom wil never changs. therefore no axial lnad aas
will develap in any member that lies in the: plane of A diaphTAg BEtwagn any fw Cansirained nodes. o) (e T

Winen ranning the buiding anelysis the odel Options = Siab Madl lab gives 3 opbons 119 dgsiagn - single disphiagm

« Slabs o define rigid diaphragms (Default Seiting) E5 Related Articles
« Single rigd disphragm at each foor level

- Mo i A oot evels Analysis Waining | Diaphagm Noges
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The difk belwaen these oplions can wilh the simple mode! below,

3 Model Ogtions

 Wodeling

Knowledge Base Community Tickets = Suling Wedel Gheck
Browse through our collection of articles, user  Ask questions, share ideas or start a discussion  View your previous fickets; kr fon fu modala Transfer S
quides and FAQs with other customers and solutions
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The One-Stop-Shop for Training Resources, News and Notifications

Launching ProtaStructure brings you instantly up-to-date with Prota’s world. Access the latest news,
software updates and learning resources all from our new all-in-one welcome screen dashboard.

StartPage X

Open Project

Recent Projects

New Project

MT43111
C:\Users\UseriDocumentsiProtaDemohodel..
14/05/2020

Dene123456
C:\Users\User\Documents\ProtalssueModels.
05/05/2020

QsG_Thal_Wind
C:A\Users\User\Documents\ProtalssueModels.

Deneme_SlabTypes
= L T ow

More News »

News

Technical Support and Remote Usage of

18/03/2020

Videos

More Videos »

Webinar | ProtaDetails 2019 New

ProtaDetails 20 / Features

~ Webinar | ProtaSteel 2019 New
. __ Features and Enhancements

DemoModel.

13/05/2020

KIRISLI_RADYE_MKGOKALP

T Protatlcle 2010 Webinar | ProtaStructure 2019 New
awrch e Features

=¥ ! cu
| 11/05/2020

ProtaStructure during Covid 19 Pandemic

Resources

@

Getting Started

A

What's New Help Center

Notification

Software Update
5.0.270

Update your software to latest version
Update

2711212019
‘Subscription expired.
Click to extend your subscription

Instantly Get Updates with the New Update Delivery Technology

Our new update system notifies you about any software updates instantly. Required files
replaced without the need to install the software.

ProtaStructure’
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Leading BIM Integration — Powered by ProtaHUB

We understand that you don’t always have all the information in the BIM-Rich format you require. So
we have developed ProtaHUB, a unique common BIM platform underlying ProtaStructure. This allows
us to understand IFC and other common model data definitions (such as 2D and 3D DXF), even if they
only have only Solid or Face representations, and seamlessly convert these to intelligent structural
models you can use in ProtaStructure.

Import IFC Files from a Wide Range of Sources

Prota continues to deliver industry leading BIM Integration. ProtaStructure can now receive models
from a wide range of IFC sources (like architectural or other structural software).

The biggest hurdle that stands in the way of effective BIM Integration today is the different
implementations and interpretations of data among the existing software.

ProtaStructure 2020 makes this easy with our unique ProtaHUB allowing you to import IFC 2x3
Coordination View data directly into ProtaStructure to create your models.

Import Model From IFC
IFC2x3, Coordination View Version 2,0

C:\UsersJUser\Documents\SAMPLES _IFC\Archicad Trials\protra.ifc

‘ Import Model From IFC

IFC File Location:

Browse
| Delete Existing Model

Foundation Depth: 1.10m

Connectivity Tolerance: 50.00 mm

Close

Remaving Existing Members. ..

Storeys are defined in the IFC file. Converting storeys...
Axes were imported successfully...
Materials were imported successfully. ..
Beams are imported successfully...

Shear Walls are imported successfully. ..
Columns are impaorted successfully. ..

Frame Members are imported successfully...
Slabs are imported successfully...

Mo Piles found to impert...

Operation Completed...

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Revit Family Mapping

When it comes to BIM, every company has its own unique way of working. From file naming
conventions, parameter names, folder structures, to unique family designations and shared parameters,
we recoginise that each designer needs a flexible approach to creating and sharing project information.

With our dedicated Revit Add-on, you can use any Revit template to start communicating with
ProtaStructure. We have developed a new family mapping tool that enables you to use your own
families to match your workflow.

frmExport

> Detail Items 450%500 450500 450%500
~ Structural Columns

300

450

600

750

300/450

450/500

600/750
> Structural Framing

QK

Import from 2D DXF Files - External Reference Drawings

ProtaHUB now allows you to take full advantage of any existing 2D drawing information, like structural
and architectural key plans, to rapidly setup and co-ordinate your models.

Have Architectural or Service Plans?

We've enhanced further our reference drawing import module. You can assign different DXF drawings
for each storey. Manage them all in a single neat environment. Have full control over how the drawings
are positioned. Change any property like opacity, scale factor, color-scheme, even the import unit and
assigned storey any time you want.

Storey Reference Drawing
Active | Storey N... | File Path Unit | Use Colors | Opacity | Scale Factor | Offset
v 1 C:\UeersYeer'\Documents\SAMPLES _DXFlArchitectural\DURULTUCU MIMAR... K mm W =—F 10 ¥ =-247.66, ¥ = -708.32
v 2 C:\UsersYJser\Documents\SAMPLES_DXF\Architectural\DURULTUCU MIMAR....  mm W == 10 X=0,Y=0
Y 4 C:\Users\User'\Documents\SAMPLES _DXF\Architectural\Architectural Plan...  .|v v =10 X=0Y¥=0
mm
n
m
Pleaze dick "Add” button to add & new external -
Add X7 Remove e@s Move & | Import | reference drawing file for a selected storey. i L4 x
DX Dxi DX Help F1 oK Cancel
2

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Hide and show reference drawings as you need. Find them the way you left next time you open your
project.

B sivvions | oty by A i ey Dmrgbhews Ol e b
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Ll W o neviontatio [ smess BH A i i Re M %8 @ g: B3 I 4
New  Open er t ot oot el
Blometnina X Omeprome | lodk © Musow  HGNFC DF  fammed  Refeens oowns T Cousetngs e Temgees | Wkiosds | Loas .
mopct Qs st satings Lout bvars sty -

|V_

ﬁ i

Storey Reference Drawing
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Achve [siey .| Fle P [ ine Gl Oty e Fackr | Ot

v 1 Cobesiie Do S GAVPLES DE Woschr ST e ¥ ——F 10 x-zumyemn |[O e
2 Coliers e Cocmenss SAMPLES DIF WehtectrolDURUT . mm W == 10 xe0,va0 © L

- — 20 x=o,r=0

S =33 CENE)

» 0 SE2(+6.00m)
» 0 53 (+a.00m)
» © sEa(s1200m)
» 0 5E5(+15.00m)

ot . AT bton 128 3
oo Q Jowt. | cernarefererce Somg e o s v x
-

Have Structural Key Plans in CAD?
Why stop there? Select a reference drawing and import elements to jump start your structural model.

! !
115mm THE. BRICKWALL WITH ‘
_‘__ . JmmTHKCERCPLASTERAND  —  — |— |~ —  — T T T
PAINTED ON BTTHS\DES. ‘
| ; -
‘ Storey Reference Drawing
Act ‘Smray |FHE Path |Unit‘USE Colors |Dpacity ‘5G|E Factor | Offset D S g O S | n—o
E_Iﬁ: 1| C:\WUsers\User\Documents\SAMPLES_DXF\Architectural\DURLLTUCU MIMART ... | mm =1 X =-247.66, ¥ = 708.32
_‘ 2 C:\Users\User\Documents\SAMPLES_DXFArchitectural\DURULTUCU MIMART_1.. | mm X=0,¥=0
4 C:\Users\User\Documents\SAMPLES_DXF\Architectural\Architectural_Plan_NR m X=0,Y=0
‘ DXF Import X
‘ |C:VJsers\UsEr\DnmmEnts\SAMPLES_DXF\Jrregu\ar_Flat_Slah.dxf | | Load DXF
?Ti Setti
Import Type : ‘Floor Plan ‘v| | Assign Layers e
=1 wid [Wember [Loyer Text Layer Unt of e : Default Seam Heigh
N Add @ Remove «b» Move @ Import -
‘ (2 Grid AXIS, AXIS2, ...| ¥ | AXIS, AXIS2, .. |¥| | Comnectivity Tolerance : 50.00 cm Min. Beam Length : 200,00 an
T~ ‘—]—_" [ Column COLUMN, CO... | ¥ | COLUMN, COL... [V |
) ‘ | wall WALL, WALLT...| v | WAL, WALLT... v Storey : Max, Beam Width :
$ I PR | _ ‘ | Beam BEAM, BEAMT...| v | BEAM, BEAMT... | ¥ | Storey Height : 300.00 am Default Slab Height : 2500 am
i N2 : | slab SLABEDGE, 5... | ¥ | SLABEDGE, 5L .. |V |
‘ | I ‘ | Pile PILE | v EPILE [w] Default Pile Length : 150000 cm
| ‘ [ RBARLENTEXTAPP ~
i CHE
‘7 . i Add /Replace : |Add l;‘ FOOTING
= — | ‘ || FOOTINGTEXT
‘ ¥ , 1 8§ /| PILE
—T %_‘ i (] sECTION
i [] sECTIONTEXT
| = 50 TH BRIBKHALL AT | [ secTiongev v
20mm THK CEM, PLASTER AND
Eyj oK Cancel
‘ = PAINTED ON BOTHSIDES. -
= e !
A/ f N
. | e
[ "
! | |

Close

Import |
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Take advantage of ProtaStructure’s new 2D DXF import where we’ll extrude and create 3D information
directly from your 2D drawings. Create gridlines, columns, walls, beams and slabs instantly and
intuitively; greatly enhancing modelling times.

All layers are examined for keywords and relevant layers are automatically assigned to member types
immediately upon loading of a DXF file. Entities assigned to multiple layers can be imported at once

[ T e e e e
A 0 i 0 \ i

2D DXF > ProtaStructure

Import from 3D DXF Files

Not all software comes with high-level BIM collaboration skills like IFC and a Bespoke Native Revit Link
as ProtaStructure does. Some of them are just bound to low-level data export facilities like 3D DXF. This
won’t stop you communicating with them anymore. ProtaStructure’s 3D DXF import feature can make
sense of 3D objects such as polyface meshes, solids, 3D solids, blocks and more.

3D DXF > ProtaStructure

ProtaStructure generates sections, figures eccentricites and even creates grids when necessary to build
a physical structural model automatically. Storeys are assigned intelligently by querying all the member
positions.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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You can even import analytical 3D models made of lines and meshes. ProtaStructure assigns default

section material properties. No grid definition is required.

Analytical Model defined in DXF File > ProtaStructure

Poster Quality Image Export

You can now create poster-quality images out of your model. Model vectors are scaled up before

rasterizing and you get a crisp and high resolution image to be used in printed media, presentations,

reports or web sites.

Export to Image

Select a view from the list and dick

‘Save...'

Kat: 1(38)

Views:

Quality: |Screen

Screen

Close

Medium
Poster
Custom

ProtaSteel ProtaDetails’ ProtaBIM’
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3D PDF Export

PDF readers on the market are able to interpret 3D information and visualize it. That allows you create
better presentation materials and a means to share your model view with your colleagues even on
mobile devices. ProtaStructure can help you to achieve this by exporting the structure’s 3D geometry
information to 3D PDF format.

[£) steelpck - Adobe Acrobet Reader DC - 0 x

7 @

Do NP3 0

i

o
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Extended Code Coverage

New Codes of Practice

Following new codes of practice are supported and the support for existing ones are enhanced in

ProtaStructure 2020:

e Thailand Seismic Code (DPT 1301/1302-61)

e Thailand Wind Code (DPT 1311-50)

e Indonesia Seismic Code SNI1726-2019

e Eurocode 2 and Eurocode 3 Poland National Annex

Page - 18

Code Country Description Code Country | Description
TS 648 Turkey Celik Yapiarn Hesap ve Yapm Kurallan (1980) TDY 2007 Turkey Deprem Bélgelerinde Yapiacak Binalar Hakkinda Yonetmelik
Eurocode 3 EU {EN 1933) Design of Steel Structures (Base Code) TEDY 2018 Turkey Turkiye Bina Deprem Yonetmeligi
Eurocode 3 {SG) EU {EN 1993) Design of Steel Structures (Singapore Annex) SNI17262012  Indonesia | Procedures for Earthquake-Resistant Design of Structures
Eurocode 3 (MY) EU (EM 1993) Design of Steel Structures (Malaysia Annex) MSCP 2015 Philppines | National Structural Code of Philippines 2015
Eurocode 3 (UK) EU (EN 1993) Design of Steel Structures (UK Annex) Eurocode 8 EU (EN 1998) Design of Structures for Earthquake Resistance (Base Code)
\Ewracode 3P0  Poland (EN 1993) Design of Steel Structures (Poland Annex) Euracode 8 (S6) EU {EN 1998) Design of Structures for Earthquake Resistance (Singapore Annex)
BS 5350 UK Structural Use of Steelwork in Building Eurocode 8 (My) EU (EN 1998) Design of Structures for Earthquake Resistance (Malaysia Annex)
AISC 360-10 (LRFD) UsA Spedification for Structural Steel Buildings (LRFD) IBC USA International Buiding Code
AISC 360-10 (ASD) usa Specification for Structural Steel Buildings (ASD) uBC Usa Uniform Building Code - 1997
TSC 2016 (LRFD) Turkey Celik Yaplann Tasanm, Hesap ve Yapim Esaslari (YDKT) IDPT 130261 {Thailand  Seismic Loading Standard for Bulding Design in Thailand
TSC 2016 (ASD) Turkey Celik Yapiann Tasarm, Hesap ve Yapim Esaslari (GKT)
L4 X L4 X
Pick Cancel Pick Cancel
Code Country Description
B58110-1997 UK Structural Use of Concrete (1997) -
CP&S Singapore  Structural Use of Concrete
HK-2004 Hong Kong  Structural Use of Concrete (2004)
T5500-2000 Turkey Betonarme Yapilarin Tasanm ve Yapim Kurallan (2000)
Eurocode 2 EU (EM 1992) Design of Concrete Structures (Base Code)
Eurocode 2 (UK) UK (EN 1992) Design of Concrete Structures (UK Annex)
Eurocode 2 (IR) Ireland {EN 1992) Design of Concrete Structures (Ireland Draft Annex)
Eurocode 2 (5G)  Singapore (EN 1992) Design of Concrete Structures (Singapore Annex)
Eurocode 2 (MY)  Malaysia (EM 1932) Design of Concrete Structures (Malaysia Draft Annex)
Eurocode 2 (HK)  HongKong | (EM 1992) Design of Concrete Structures (Hong Kong Annex)
‘B (EN 1992) Design of Concrete Structures (Poland Annex) -
04 X
Pick Cancel

RSA Results Sigh Method

Response Spectrum Analysis calculates and combines the pseudo maximum responses of natural
vibration modes against a given design spectrum by assuming each mode as an independent single
degree of freedom system. During the combination of modal result vectors, the sign of the
displacements and internal forces are lost and hence equilibrium condition is not satisfied anymore. If
you check the deflected shape of the structure under response spectrum load cases, you may see weird
displaced shapes due to this fact. Also, internal force diagrams will always be positive after the
combination. This is the expected behavior and natural output of response spectrum analysis.

ProtaStructure’

ProtaSteel’
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Most of the time, this is easily overcome during the design by combining RSA load cases with dead and
live load cases using both negative and positive coefficients. However, for deflection checks and other
structural checks, you may need the signs of the internal forces and deflections.

For this purpose, ProtaStructure hosts a setting to either use the ‘Absolute Values’ or ‘Sign of Dominant
Mode’ for RSA result sighage.

Results Sign Method for RSA:

-
| | Ilze absolute value -

oo+l

—
| | Use absolute value

+b o+

-
| | Use the signs of dominant mode

+ -

If dominant mode signs are used for overall RSA results, then the dominant mode will be selected
depending on its mass participation in a certain DOF, and the sign of that mode will be used for the
particular RSA load case in the relevant direction. This approach may yield unexpected results in highly
irregular structures where the dominant mode is a torsional mode or translational mode with high
coupling.

Edge Walls Bending Contribution Checks

To assess structural system load distribution within the lateral load resisting system, you may want to
mainly review the moments or shear forces carried by edge wall groups to the overall overturning
moment or base shear.

The new wall grouping functionality in ProtaStructure allows you to create groups of walls and assess
the base shear and moments carried by them against the structural output.

™ | ™ | ™ N |
Building Outer Edge Wall Groups. X \ | \ | \ | \ |
Grous e s [ ] S =
Perde Grubu 1 (X Yénii - AltKenar) P1, P9, P19, P20 x L il g 2 o N
= B I ) 3 == [ (Lo =
Perde Grubu 1 (X Yéni - Ust Kenar) P4, P5, Pe x §] ; \ P . F .
Perde Grubu 2 (¥ Y6nii - Sol Kenar) P3,P2,P1 x | oy | s | S
Perde Grubu 2 (Y Y6ni - Sa Kenar) P8, P12, PO x .
L — e —— —— e ———— e e e e
A A A B
| Il L[ N !
I I I ™ I
\ \ 1 I & || &
Hlci L
—_— e — oy ———— e —— — — ——— — i — — —
1 LS
pEa |
| \ [ |
i i =
I | Il |
| H e e i B "
[ I
| | | | |
| s \ s i x L
D (2) (3) (4 ‘\.r,/\ (8) ) \3,\ (9)
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Usage of Different R values for Each Orthogonal Direction

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

Page - 20

Users can now define different structural system types (different R behavior and overstrength factors)

for two different orthogonal directions.

{ Direclion 174 Direction 2 (1)

ASCED7 Respense Spectum; Soil-A R=7; I-1; Sds-0213; Sd1-0.053
oz System Category: | D. Dual Systems Wnith SPECIAL Me- |
1 . 7,250 0.213] Structural System Type: [1E) ~
0:: % Behaviour Facter, R: 7.00
orol ] + Qverstrength Factor, Q0 250
o8 | : Displacement Scale Factor, Cd: 550
017
016 ‘ Redundancy Factor, p-u: 1,000
015 Redundancy Factor, p-l 1.000
014
013 ‘ —

oz

T o
01§
0.09
008 - N
0.07 N
005 !

|l Display Elastic Spectrum| | @ Show Markers| [Direction 1| Directian 2 (= ®
® = o ®
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Modelling

Our New Flexible Frame Member

ProtaStructure supports practical tools for quick ) =
insertion of steel members such as purlins, girts, T
trusses, braces, sag-rods, and so on.

To provide even more flexibility for you to model
steel structures, we have introduced the free
“Frame Member” that you can insert anywhere
in the model.

Frame member sections can be rotated in any
orientation, and local offsets can be assigned
without compromising the analytical model. You
can assign end releases in the direction of any

degrees of freedom.

Custom Truss Editor

ProtaStructure provides an extensive library of parametric truss members. You can easily select truss
type and pattern, set the parameters and insert the truss.

To provide you with even more flexibility we have introduced a brand-new Custom Truss Editor to create
custom trusses of any shape.

Custom Truss

: - - X +
e mEmasm B AT L o X v X
Top Chord Bottom  Vertical Diagonal Horizontal — Clear Al Clear All Create Points  Divide Add Extension Measure Distance OK  Cancel
Chord Frames Guidelines  Btw Two Points Frame Point of Two Nodes
= > ==
x| 7 i [xj®= x/®
. 250.00
. 1000.00 . 1250.00 . 1250.00 1250.00
[
250.00
.
.
&3
250.00
3
L
x
250.00
.

=]

1000.00

Il oo chord
I vertical
- Diagonal
- Herizontal
\:l General
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Convert Any Parametric Truss to a Custom Truss

Truss Types

You can also start with any parametric truss in the library and customize it | <R[/ NN/
to your needs. As you develop this, you can return back to the parametric
truss library and come back to your custom design as needed. Your draft M @

is cached for you, in case you change your mind. AN 5%
Convert Free Frame Members into Trusses m_m
Custom

Create any free geometry in 3D modelling environment using free frame
members. Then select and convert them into a single truss element.

& = Custom Truss Truss Generator o x

General  Splices  Members | Editor

) ndo - X X + . W
IR R IR 2 - vy 7R L G
rede | A KD A AN £ P = e A ‘/ X
TopChord Bottom  Vertical Diagonal Horzontsl Clear Al Clear Al CrestePonts Divide AddExtension MessreDistonce  ZoomExtents  OK  Cancel
Chord Frames Gudelnes BtwTwoPonts Frame  Point of Tuwo Nodes
-~
% [+ x| [+ e X [+ X [+ B [+ X [+ x| [+ [ [+ % [+ X
625.95 1261.90 625.95 801.22 1702.58 1702.59 801.22 499.54 1378.31 625.95

B |3125

625.0

H

63.11
249.3¢

=] &

Chord Types

- Top Chord

4 I oo Chona
B vertical
- Diagonal
I Horizontal
[ ceneral

Save Your Trusses to the Library and Share

Save any custom truss to the library where you can use it in other projects or simply share it with your
colleagues.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Truss User Defined Library n

C:\Users\User\Documents\Protalib\Custo mTusses

4 DXF
Py

Mid-Triangle Truss { L= 500 mm, 12/05/2020 }

|
I
/

Studio Vault 2 { L= 761.520000000011 mm, 27/04/2020 }
t ilt Type Triangular Roof Truss

Studio Vault (L= 1500 mm, 13/04/2020 }
A vault type truss...

Trianglel (L= 761.520000000011 mm, 27/04/2020 }
Triangular Roof Truss

% 8 % { L= 500 mm, 07/05/2020 }

| Stretch Truss in X-Direction a Cancel | (@ Load
4

Edit Multiple Trusses

ProtaStructure 2020 allows you to edit multiple trusses at once. Selected trusses must be of the same
type. This is an extremely efficient tool in case you need to change your design decisions after you have
progressed in your model.

Steel Trusses: New Features and Improvements

Bottom Chords Perpendicular to Supports

A new option is added for trusses with sloping bottom chords. “Make Bottom Chord Perpendicular to
Support” option can be preferred for ease of constructability.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Slope Angle for Top Chords

In addition to Left Heel, Right Heel, and Apex Height, top chord inclination can also be defined with
Slope Angles. For example, if the roof slope is known as a percentage, say A%, the angle can be
calculated by the formula arctan(A/100). After Apex Height is specified, Left and Right Heel heights are
automatically calculated using the given angle. Activate “Enter Left Heel by Angle” or “Enter Right Heel
by Angle” options to use this feature.

Mumber of Spans (Right) 4
AR 5y Wy e o

Inverted Truss Types

All truss types now support an “Invert Truss” option.

Specifying Heel Height for Curved Trusses

Left and Right Heel Height can now be specified for curved trusses.

[P —— - o x

P ——
s — 3| | -
— | e — S — — e .
e | ANDn BN | AR oese 7]|| | v AN W AN i
Masbers. w g2 Mersbers. Left e egne. " 00000 mn
- A A | AR R = - S e : C —

HA

Vew
neset

¥ x| X o v o X ol

Trusses with Different Number of Joints and Spans

Purlins can now be inserted on trusses with different spans and number of joints. The shorter truss
governs the purlin layout.

Inserting Purlins on Bottom Chords

A new option now allows purlins to be inserted on truss bottom chords.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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v ox X e

A New Truss Type

A frequently used “Scissors” type truss with different Left Heel, Right Heel, and Apex Height can now be
inserted.

Divide Cross-Diagonal Members

To quickly insert gusset plate connections on cross-diagonal members, we have introduced the “Divide
Cross-Diagonal Frames” option.

e | A N
A 5%

XXX

Delete First and Last Verticals

The deletion of first and last verticals is now an option rather thanan automated operation. If this option
is checked, the first and last vertical members are never generated in case of any parameter change.
Additionally, if truss placement is set to “Top Chord,” then first and last verticals are automatically
deleted for convenience.

IU'J g T\IHIILI_AI.CIIEIUII Wy
Verticals

o i f vertical

Delete First and Last Verticals @
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Insert Multiple Braces In One Go

Horizontal, inclined, or vertical braces with correct offsets, correct rotation, and orientation can be
tricky and time-consuming to insert. Our new brace tool allows you to insert multiple braces with a few
clicks to truss top and bottom chords, beams, and columns.

In the editor, you can select and change multiple brace properties at once. Moreover, you can delete or
reposition individual brace offsets to further customize your brace pattern design.

To... Count - Labet

Section and Type
Profle

Brace Type
Qut of Flane Algnment
Custom Offset

1 RO
To... Count.
1 cros
2 cra?
Bat... Count *

Reset View X Gaproz 5t

Braces Between Truss Top and Bottom Chords

With ProtaStructure 2020, you can insert braces between truss top chords and bottom chords. Previous
versions of ProtaStructure was only supporting brace insertion between columns and beams.

Extended Steel Profile Library: Thailand and Philippines Profiles

Commonly used Thailand profiles of RHS, SHS, CHS, |, H, C, T and CWL extends our ever growing profile
database.

Column Steel (HE300A)
Razizs - 1150X75%9.5
— Fso 75 [les | S
= MALAND T 200 100 10
5] 150 16
E'E BS
250 125 125 19 H Bw
[ LI 300 150 13 18.5 22
R1
=) 350 150 15 24 . 112
— 400 150 18 25 Bz 2
=1 sicapore 450 175 20 26
500 180 25 35 H 150 mm
E= vaiavsia - 75 mm
H1 5.5mm
= . 4 JAPAN Bw 9.5mm
— B2 75mm
— THAILAND
— H2 5.5mm
I T M 17.13655 kg/m
Ao 2183 mm2
O CHS 111 5120000 mm4
122 575000 mm4
E oo Well 102000 mm3
We22 15300 mm3
Wp11 0 mm3
Wwp22 0mm3
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Transfer Columns and Walls with Rigid Links

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

You can now mark walls and columns as “Transfer”. Once marked this way, there won’t be any
discontinuity message issued during the analysis. Additionally, if transfer columns are inserted on
different gridlines, ProtaStructure will create rigid links automatically. Additionally, the design of
beams supporting these transfer members is improved.

1C2 (100022507

(B )

*

.| Column Properties

Gen | Drop | 3D |

EI Flane (Top):
ﬁl Flane (Bottom):

=]

(mm) del z (Top):
del z (Bottom):

=]

!
|
mSLOAXSL (o
|

Support Type:
[Default] s

o Update 3 Close \

S2 @ Axis 2

1C1 (10042507
1 (A

) e

|

|
1
O

[N

_ Since column S2
marked as ‘Transfer’ it

Since column S2 not
marked as ‘Transfer’ it

is automatically
connected with a rigid
link.

is not automatically
connected with a rigid
link.
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The New Settings Center

All project and system settings under one Ul

Creating simple seamless user experiences is at the core of ProtaStructure 2020. We have now
categorized and collected all settings and parameters under a single unified ‘Settings Center’ that will
enable you to tweak and fine-tune your design decisions easily.

Options

[search settings...

o

~ @ ProtaStructure Environment
View & Save
Display Settings

> @l ProtaDetails Environment

Concrete Design Code
TS500-2000
Turkey
Betonarme Yapilarin Tasanm ve Yapm Kurallan {2000)

Steel Design Code

TSC 2016 (LRFD) i

3  Project Preferences Turkey Optlol"l s

Unit and Format Gelik Yapilarin Tasanm, Hesap ve Yapim Esaslan (YDKT)
> Iz Label

e Labe | column

Codes Loading Code
TS 433
5 [ Column & Shearwall Turkey ~ [ Label
Yapilara Uygulanacak Yiikler i
> I=1 Beam | Settings
3 7 Slab (&) : ; " 0
. Earthquake Code - Column & Shearwa

> A Fou-ndatlml 8DV 2018

& stairs Turkey v Rebars

Il Retrofit Wall Tiirkiye Bina Deprem Yonetmelii | )
> SteelSettings Column Containment
5 Analytical Model Scttings + = Plan Details

- Form Plans & Column Applications

7 scales
> % Rebar

» 7 Plan Details

Template Management

Help F1 H oK

|| cene

Search to access desired settings

You can perform keyword searches to find the parameter you need. It can be as simple as Concrete
Cover, Column, Splice, Foundation, etc
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Analysis

New Analysis Post Processor

A Faster, Integrated Experience

The new integrated 64-bit Analysis Post Processor provides significantly superior performance with the
help of the latest graphics technologies and methodologies. Displacement animations, diagrams, and
contouring are now much faster. Switch instantly between analysis and model displays or tile them for

concurrent viewing.

M11
(kN.m)

-17.9
12.0
420
7.9

1018

1318

1080

Shel: 691 Properties

Solid Analytical Model View

See results in our new Solid Analytical model. Enjoy the harmony of physical members dressed in color-

coded analytical results.
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Pushover and Time-History Analysis Results Display

If you have performed a nonlinear Pushover or Time-History Analysis, the new analysis post-processor
will allow you to visualize the results including time steps and progressive pushover behaviour.

Placeholder Image

Lorem Ipsum

Display of Selected Results

It can be hard to navigate analytical views through complex models. ProtaStructure allows you to show
labels for selected members only to allow you focus on what you are working on.

~ Rigid Members % Local Axes T [ shellNo A Thidmess HF'
#* Hinges A’ Direction Fillly A, Shrink A" Materials 2
. Frame | Shells N Show Labels for
" Shrink Loads A, Surfaces A7 Pressures | Selected Members Only

e Members Shell Members
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Connectivity Helper

Connectivity issues function lists all the frames with suspicious support and connectivity conditions. You
can revise and highlight any frame from that list.

ProtaStructure 2020 / Project: MT43 Analytical Model
a ! Analyss ~ Design  Drawings &Reports  BIM  Display  Views  Help Members ~ Results  Contours  Solid Model
Save Picture ® {_: v o
™| Y e B
Find | Filter | Connectivity || Linear Pushover Time History
Issues
Tools Analysis Result Type
Storey: 1 (Plan) Storey: 4 (3D) Analytical Model 2
Filter £ ——
Storeys ~
All Storeys
Storey 0
Storey 1
Storey 2
Storey 3 Hement }u.w . pported At
Storey 4 106 (K120) 1
Axes ~
Al Axes
A
]
c
2 S6 :
3
4
5
&
1
2
@1
@2 ¢
@3
@4
7
E 13
8
F 0
Member Types ~ e
Al Members K103
Axes | () Mode
Columns (®) Frame o
Shearnals -
Beams _ Oshel
Slabs < .
Braces i
] -
Purlins
Girts

Diaphragms

Visibility of each diaphragm can be set independently

._ M1 : Loads & /
Y & Supports =

Modes  Labels ; Diaphraams | Frames
2 Springs
MNodes select All
De-5elect All

=1

- . v Di-1
o & @ C(\' cﬁ D2-1

|Search... v D31 i

[ m i T
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@ rrota

Grid Layout

Analytical views can show model positioned on the actual grid system

I

- 4__
4/. 0~ _<

ProtaSteel ProtaDetails’ ProtaBIM"
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Nonlinear Analyses with ProtaStructure- OpenSees Integration

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

What is OpenSees?

The Open System for Earthquake Engineering Simulation (OpenSees) is a software framework for
simulating the seismic response of structural and geotechnical systems. OpenSees has been developed
as the computational platform for research in performance-based earthquake engineering at the Pacific
Earthquake Engineering Research Center.

OpenSees has advanced capabilities for modeling and analyzing the nonlinear response of systems using
a widerange of material models, elements, and solution algorithms. The software is designed for parallel
computing to allow scalable simulations on high-end computers or for parameter studies.

OpenSees provides beam-column elements and continuum elements for structural and geotechnical
models. A wide range of uniaxial materials and section models are available for beam-columns.

Nonlinear analysis requires a wide range of algorithms and solution methods. OpenSees provides
nonlinear static and dynamic methods, equation solvers, and methods for handling constraints.

OpenSees is open-source. The open-source movement allows earthquake engineering researchers and
users to build upon each others accomplishments using OpenSees as community-based software.

(Source: https://opensees.berkeley.edu/OpenSees/home/about.php)

Automatic Transfer of Analysis Model and Nonlinear Material Properties

ProtaStructure analytical model is communicated to OpenSees via TCL files. In addition to the detailed
analytical model, nonlinear material properties are also automatically calculated and added on top of
this model. The entire structure is then ready for performance analysis.

Due to license rules, we are not distributing OpenSees.exe with ProtaStructure. You can download it
from https://opensees.berkeley.edu/OpenSees/user/download.php and copy to the ProtaStructure
installation folder (default C:\Program Files (x86)\Prota\ProtaStructure2019EN).

TCL/TK libraries must also be downloaded.

Nonlinear Fiber Analysis of Sections

Column, beam, and Wall sections can be modeled with fiber elements and analyzed with state-of-the-
art numerical techniques to derive the Moment-Curvature relationships. Confined and unconfined
concrete regions can be specified. Strain hardening is taken into consideration. For more accurate
analysis, you can create the fiber mesh around rebars.

The user interface for fiber section analysis is not released yet, however, the underlying technology is
used to derive the force-deformation relationships of the members for pushover and Time-history
analysis. The meshed picture below is provided to give you an idea.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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For column and wall members, a ‘Finite Length Hinge Zone’ model with 6 integration points is used.
Shearwall members are modeled with a distributed plasticity model, again with 6 integration points.
Force-deformation relationships for integration points are obtained from fiber section analysis.

Plastic Nonlinear Finite length

hinge spring hinge hinge zone section element
{ J AN J
R & o &
Concentrated plasticity Distributed plasticity

Nonlinear Static Pushover

Single Mode Static Pushover analysis is performed using ProtaStructure - OpenSees integration.
Plasticity models are used as described above. Parameters such as the number of steps and target
displacements can be controlled by the user.

After the analysis, the Capacity Curve is obtained. Users can specify the monitored node for which the
curve will be generated. Results can be examined at any desired step. A detailed performance
assessment report is generated after. Nonlinear static pushover is accessible at Analysis > Building
Assessment menu.

Column Table (Dir:0°)

T T T
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S0 g som  WEE 3B 8w e B0 oI oos Dwie Y Goow  omm oo oo oo *lren
Sl e w0 48 au ws e O 0o Dt ¥ qaet  om oo oows oo L
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Perft Goal: C

Performance Assessment Report

Esriepsake Lavel D02 - Perkcrmance ol are not Ssbed. %

Pushover Curve

0.06

W oo1oen
Displacement(m)

0.8

Nonlinear Time-History Analysis

Report

Pushover Analysis Type: | Equivalent Static Pushover Analysis v
Total Number of Steps: 100
Pushover Direction: | 0-Degree -

Cantrol Node: | Selection MNode | Storey ~

v D5-1

Target Displacement: 0.109638 m
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A nonlinear Time-History analysis can be performed using ProtaStructure - OpenSees integration.

Plasticity models are used as described above.

A set of multiple ground motions can be applied simultaneously in X and Y directions. As specified by
the earthquake codes, the ground motion application direction is rotated by 90 degrees, and analyses
are repeated. The selection of suitable ground motions is up to the user. Parameters like fault
mechanism, soil properties, magnitude are of importance. Nonlinear time-history analysis is accessible

at Analysis > Building Assessment menu

General
Parameters
Nonlinear Analysis

Ground Motion Sefection
Ground Motion Scaling
Time History Parameters

Cutput

Pushover Curve
Detalled Resuits
Resits
Detalled Reports
Reports

"B Existing Building Assessment Methods

4dd Ground Motion (+) || Delete Ground Motion ()

Ground Motions
GM1 ZL Landers_1952
GM2_22 ImperialValley_1573
M3 22 Imperialvalley_1579
M4 73 Landers_1997

M5 23 Imperialvalley_1573
GM6_73 _Tainan_SMART1_1585
GM7_Z3_Northridge_1994
GMB_23 _Loma_Priets_1989
GM3_24 Landers_1992
GM10_74 Landers_1332

GM11_74 Tainan_SMART1_1986

x
Delete Al Edit X Direction GM EdtvDrectongM [ SetDefoultaMs
XDrecton GM Preview ¥ Drrecton GM Preview Y
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4
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The selected ground motion records are automatically scaled by ProtaStructure using the simple scaling
method between 0.2T and 1.5T.

Acceleration (g)

Scaling Parameters
Spectrum Factor:
To (s)
Lower Bound Factor:
Upper Bound Factor:
[ Edit Manually

Plot Options

Plot Target Spectrum

Flot Scaled Target Spectrum
Plot Unscaled Spectra

[ Plot Scaled Spectra

[ Plot Average Ground Motion
Plot Scaled Average Ground M
[ Flot anly scale Region

[ show Legend

14 16 1.8
Period (s)
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@ rrota

The analysis results from multiple ground motion sets are automatically post-processed. The average
values of absolute maximum responses are extracted and used in performance assessment.

A detailed performance assessment report is presented. Additionally, the analysis results for a specific
ground motion at a specific time-step can be looked up by the user.

Ground Motion Graphs
[5M1_z1_Landers_1992
m MAverage Envelope Results
T o
5 ["1 specificTime History Results
g o
*g 0t Analysis Labe
2
] s 10 5 2 2 20 E 40 a5 50 .,Jf Envelope Results 1
Time(s)
Scaling Graph
14 —
— Target Spectrum
—— Scaled Target Spectrum £ 200
12 —— Unscaled Average GM Z
- Staled Average GM =£, 150
: €
5 o 100
5" % 50
g 0.6 - ]
D 0
2
8
< 0 0.1 0.2
04
Curvature (rad/m)
02
Svee E Show Idealized Bilinear Curve:
. = tenean,
0 1 2 3 4 5 6 7 s ] 10 .:é:. IEnd .::::. JEnd
Period (s)
@or1 ()02
Time History Parameters
Analysis Label ‘Ground Motion ‘Label of Ground Motion in X- ‘ ‘Label of Ground Motion in Y- Scale Total ‘ Analysis Time Axlal Force USEd In Moment—curvamre
Labe irectis irectit Factor Durati Stey -3
GM1_Z1_Langers_1092_X Gm_zw_:snnecs Z|_lede;f1992_AB‘ll}QD\ z|_L;me$wgz_BAKmu\ 255 5 :;gs\ t cﬁ Analysm + 68,221 {t)
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RC and Steel Design

New RC Beam Design Module

RC beam design module is remastered and improved with better usability, visualization and new
features.

Beam Design Editor: Familiar Interface, Better Technology

You can see beams of design axis in 3D and manipulate the geometry easily with visual feedback. More
detailed information is available on design parameters for selected concrete code.

Beams  Rebars
A A v X
Interactve  SideView 3DView ~ OK  Cancel
Design
View Exit ~
Axis: [A Storey: [1 Part: [1 Conerate: C25/30 - Fek = 25 - Fed = 16.67 (Njmm3) Beam Supports
Enter Steel Bars Manually (Do not design) Steel: Grade 500 (Type 2) - Fyk = 500 - Fyd = 434.78 (Nfmm2) Beam Axis : A I-End Asis : 1
s e s . N Clear Span : 5373.23 mm 1-End Axis : 2
pan lear Span W
Aads Merber (mm) mm) (mm) (mm) bw : 250.0 mm 1-EndLabel : 1c6
1 B1 5379.23 5127.27 250.00 500.00 h : 500.0 mm 1- End Sup. Condition : Column
2 162 5000.00 425067 250,00 500.00 delz -1 : 0.00 mm J-End Label : 1c13
4 B3 4000.00 372227 250.00 500.00 delz -3 : 0.00 mm JEnd Sup. Condition : Column
Top Suppart Exist at I-£nd : v
Top Suppart Exist at J-End : v
< BeamSection | i) 1-End Section 3 -End Section (7]
Beam Design Parameters - 181 ﬂ
Bending Shear & Torsion
vd - Left 36,7k
i (mm) 4390 4480 4510 Vd -Right BTN
KiK 0.12 0.01 0.16
x fmm) 56.1 56.1 564 d DEET
d As (mm2) 172.29 8.60 22119
v As' (mm2) 0.00 0.00 0.00 Materials
ConcreteMaterial 2530
32.0kM.m 1.6kNm 41.2l0Lm Rebar Material : Grade 500 (Type 2)
Moment Link Material : Grade 500 (Type 2)
7.4kN.m 26.2kN.m 1.3 kN.m
X
h' {mm) 451.0 451.0 451.0
KK 0.03 0.10 0.00 L
x (mm) 56.4 56.4 564
I T, | s 5 P
As' (mm2) 0.00 0.00 0.00
"
Unit of the Rebar Area: mm2 Manualy Edit
« 0K #® cancal

Copy/Paste Rebars to the Neighboring Beams

Selected rebars can be copied to the clipboard using right click or simply Ctrl+C combination. Then you
can paste them multiple times to different targets using Ctrl+V.

The whole rebars of a selected beam can be copied to multiple neighbours using Copy Bars, Paste Bars
and Paste Bars to All buttons. The support bars will be copied intelligently taking level differences into
account.
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T - Reinforcement Data - Axis: A
Beams | Rebars
. == <l Previous Span <L Extend Left to Lap 23 Copy Bars
Th e M s . v K
— s ExtendRight tolap ~ L Bar at Layer 1 [, Paste Bars
Select  Diagrams  Detall Display Not Scaled Design OK  Cancel
Bars - Drawings Moment Values —3 Cranck RightEnd - [ PasteBars to Al | peport
Steel Bars Copy /Paste Repo Exit
2 4
[P 3000 ! 3000 .
1B1 ~7 ' 1B2 ~7 , L1B3
Required As(mm2) 17229 8.17 2119 1 24E RE 18985 1 11507 6082
140.77 140.77 11819 | 11470 118.91 11891 | 88.99 88,99
250x500 | ! 2501500 | 1
5127 500, 4251 4500, 3722
+—+ +—+
Extra As(mm2) ‘ |
Top Bar 2H16 _ , | _ 2H16 ‘ . 2H16
Support Top Bar 3H12 3H12
Support Top Bar
Bottom Bar 3H12 = b
Ui
Bottom Bar dnde =1 po===
Support Bottom Bar Cut
Web Bar & Copy
Links 1H8-100 1H8-2 Paste 10 1H8-100 1H8-200 1H8-100 1H8-100 1H8-200 1H8-100
As-min (Top) 149.72 149.7; Delete 0. 150.38 149.72 150.38 150.38 149.72 149.72
As-min (Bot) 150.38 1503 Select All 0. 150.38 150,38 150,38 150.38 150.38 15038
s-Bar-CL (Top) < 168 > < 168 86| <86 > < 168 > < BB > < 86> < 168 > < 168 >
s-Bar-CL (Bot) < 86 > < BB > < 86 > < BB > < 86 > <86 > < 86 >
Deflection Check L/d = 11,93 < 100.49 L/d = 1109 < 137.27 Ljd = 8.87 < 156.96
*-Sup. Links 1000 1000 1000 1000 1000 1000

Beam section dimensions can be changed without leaving the rebar selection. Simply click on the

dimensions text and amend.

1 2

y | 181
} 1 17229 85.17

14077 140.77

1
250, 5127
]
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Steel Deflection Checks

Page - 39

The deflection of steel members can now be checked to EC3, BS5950, AISC360 and TSC2016 codes.
You can modify the deflection limits for different member groups using the “Settings > Steel Design
Settings and Parameters” menu. Additionally, you can override ‘Deflection Span’ and ‘Deflection

Limits’ for each member.

Steel Design Settings and Parameters
| Deflection Check Member Connection Groups
You can change the default deflection limits for each member group.
Category Q I GHQ|
Floor Beam 0 360 i
Cantilever 0 180
Roof Beam 0 360
| Purlin/Girt 0 200
Reset to Defaults
¥ X
oK Cancel
Deflection Check
Deflection Span: 5000.00 mm
Category: Floor Beam
dv (mm L/dv
GHQ: 0.2 21,150

Improvements in Steel Beam and Truss Design

V2 (kN)

M33 (kN.m)

52 (mm)

53 (mm)

Frame ID

0.985

QR

-0.985
-0.001 -9.1E-4
1.229
0.3 -0.3
0.9
0.9
\\ Design Summary | Parameters
["Bucking | Deflection
(] Manually edit deflection span
189
'L'=5-°° (m) "] Manually edit defiection limits

Set the related field to ‘0" (Zero),
to use the automatically calaulated values

Significant improvements are made in buckling length calculations of steel beams, top and bottom
chords. Detection of connecting members such as horizontal braces, purlins and beams are significantly
enhanced. Additionally, a new option is introduced to consider the effect of purlins on beam buckling

length calculations.

Steel Design Settings and Parameters

Beam Design | Member Connection Groups

Deflection Check

m Allow purlins to reduce beam lateral torsional buckling length
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Foundation Design

New Pad Footing Module

ProtaStructure 2020 introduces a new pad footing design which brings new functionalities:

Page - 40

e Automated design for depth.
e Top and Bottom bars can be separately edited and introduced.
e More transparent and interactive design experience.
e 3D rebars are visualized and used in detailing.
Pad Footing - u] X
Geometry Pad Footing Geametry Column Dimensions D Views | 30 View
Footing Label: F-1C13 b1: 5
Geometry
Depth: 640,00 mm b2: 500.0mm
Analysis Footing Taper Height: 0.00 mm
Materials Concrete Cover: 40.0mm
Options Lx: | 2400.00mm |3
Column Loads
Ly: | 2400.00mm | §
Rebars Square Footing
Rebars Pad Footing Eccentricty
Eccentricity X: 0.00mm | 5 aiifl iz
E tricity ¥ 0.00 : ﬁ@ H
oty vs | ocomm3] (ol
Design
Sol Stress (Net Bearing Capacity / Maximum Sail Stress) KNfm2  250.00>247.60
Reinforcement in X-Dir (13H16 / 200.0) (Provided /Required) mm2 | 2010.62>1872.00
Reinforcement in Y-Dir (13H15 / 200.0) {Provided / Required) mm2 | 2010.62>1872.00
Punching Check At Column Face (Capadty / Demand) kN 2133.3>1274.2
Punching Check At Distance d fram Column {Capacity / Demand) KN 2133.3>1274.2
Shear Check At Face of Column X-Dir (Capacity { Demand) KN 453.6>452.8
Shear Check At Distance d from Column X-Dir (Capacity / Demand) N 466.4>340.9
Shear Check At Face of Column Y-Dir (Capacity / Demand) KN 453624528
Shear Check At Distance d from Column Y-Dir (Capacity / Demand) KN 466,4>340.9
Design Generate Report oK Cancel

Batch Design of Pad Bases

When multiple vertical members are selected to insert pad footing a batch interface is opened to allow
you to design all at once. You can group selected items or import a set of pad footings from CSV or Excel
files. Batch reports can be prepared or design can be revised any time from the same interface.

-}
Design
Check Design(Do not redesign)
[&3 ®) Check Design(Redesign if fails)
Design
Al Redesign Al
Design
Label Columns
» |F-1C13 iC13
F-1C14 iC14
F-1C7 17
F-1C8 1cs

Pad Footing Batch Design

@C [DD] [DC* of Select | Clear Al o
g = =) o
Design Group  Ungroup Reverse
Selected  Selected Selection
Grouping Selection
Depth Lx Ly
450 1800 1800
600 2300 2300
490 2400 2400
400 3000 2000

o B
Foundation Design
Settings Log
Options
Base
Xf
1xBH16-250
1x8H16-250
1%13H16-200
1x13H16-200
1x7H16-250
1x7H16-250
H16-200
H16-200

)

Import
From CSV

Import

B =

Export ExportTo
ToExcel  Report

Export
Top
XY
10H14-200
10H14-200
13H14-200
13H14-200
H14-200
H14-200
H14-200
H14-200

E

Detaled

Design Report

Side
e
H12-200
H12-200
H12-200
H12-200
H12-200
H12-200
H12-200
H12-200

v X

OK  Cancel
Quit ~
Design
Status
X

X

o
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Design All

A single intuitive interface is available for fast access to design all members in the model at once.

Building Setout Modelling Loading -
Batch Design Options

U W |J£|—| Re-select Bar [ Design

- . Column,/Wall Reinforcement Design
Columns ~ Storey  Rib Beams Foundation O A “ O
Beams Beams [ Beam Reinforcement Design O
Re-Select Profiles

[] steel Member Design Chedk

oK Cancel

Drawings & Reports

Detail Drawing Preview

Preview your RC detail drawings and make sure that everything is in place before switching to
ProtaDetails.

\Il— el

-

|
I
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Embedded Reports

Analysis and design reports can be displayed in a separate docking panel just like a regular view. It is
more integrated and convenient this way for you to review the reports while reviewing the models at
the same time. You can even tear out the docking panel and place it on your second screen.

. -8 x
o [ Beven | i Dot Dumeobfes O Oy Vs b
v e = o = -
: A BH H = @& £ @ =g
Buldng Redabel  Move Members Delete Fixthe Purge Desgn  Colrn  BeamSectons Materials  Seam Wal  Slab Addmonal | Liveloads  BIM Integraton
WS R R iR e S o | 50 S e e
— -

Slab Live Loads

ceRaQ

suopuquen peo

« A strucare
b2 s

A s
o Storey: 1(30)
B Anlyscal Model 1

4@ Regorts
o Pre-anaysis Chedks
) Egeruae£Q anal
22 Detal Prevens.
Py
» © SE0(+.00m)
4 © St:1(+3.00m)
+ [} coms
»  shearvials
» 7 teams

+ < sake
< R St

+ B Stbstie
X races
- Tsses

e Vd .
Displacement [None| 4G+0-Ey++Ez) - Hax:0.03
e e

39708

2.646705
4065257
4.673847

“

» © St2(s6.00m)
» @ 5 3(+2.000)
» o st 4(+1200m)
» © 5t 5(+15.00m)

8.678400 527596 B
9.327054  50.6030€1 3434

IPATING FACTORS

sorsquia oo |

igens Analysis Resul K <Pgelt | A >» BN v

3D Rebar View

Detail drawings are extracted from a central 3D model in ProtaStructure. Now rebar detailing can be
viewed in 3D as well. See how containment is conducted precisely in 3D.

6 © B i = = B 28

ProuDetals FomPwn  Cohm s on Pad o Repert  Reper
Acckcations Bevasars Bevators Mg

Repert -

CRRLLY R

+ © 5t 2(s6.00m)
+ © 513 (+9.00m)
+ © 5t 4(+12.00m)
+ © 5t:3(+15,00m)
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ProtaDetails 2020

ProtaDetails 2020 enhances and refines productivity with automated reinformced concrete detailing,
drawing management and dwg drafting, together with our growing library of element design and
detailing macros

New 3D Pool Analysis, Design and Detailing Macro

A new pool macro is introduced. Setting the shape of the pool is very simple. You can use preset
geometries from the library or just edit the plan coordinates. Moreover, you can define different soil
models for each wall stem according to US and European standards. Stability checks, seismic, and RC
design under design and service scenarios are done automatically, and rebars are visualized in 3D.

5 Do § = B g «

L)F W1Sol Model — x
Input Code Settings
Code : [Turkey <] sps | osm| k| 0.053]
Settings
Seismic Code : [TEC2018 -] R 1500 o] 0.105]
Soil Model
Soil Profile Edit Manually [
Surcharges
Results
Results
Lot Loz L03 Lod4 Lo5 LO6

A Glimpse to the Future of ProtaDetails: 2D Details from 3D Information

3D visualization of the rebars is not just a static display. All the 2D drawings are automatically generated
from 3D rebar definitions. This yields much more efficient and accurate detail production as well as
guantity take-off.
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New Pad Footing Module
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A

Page

Poal Quantity Table

sz UNTWESHT (Hgim] LENGTH{m)
ei2 0889 73832
old 313536 38149
TWEIGHT (Kg)

ND sSZ= Qua LENGTH {cm] TOTAL
1 | 1 283 33150
2 12 5 570 20520
3 12 0 285 13850
& 12 38 37 13320
s 12 18 802 108.35
g 12 28 402 11258
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ProtaDetails 2020 introduces a new pad footing design library which brings new functionalities. This is
the exact same design module used in ProtaStructure. You can use it independent of ProtaStructure

using your own analysis results and prepare the documentation.

e Automated design for depth.

e Top and Bottom bars can be separately edited and introduced.

e More transparent and interactive design experience.

e 3Drebarsare visualized and used in detailing.

Pad Footing

Geometry
Geometry

Analysis
Materials

Options
Column Loads

Rebars

Rebars

Pad Footing Geometry
Footing Label: |F-1C13

Depth: 640,00 mm
Footing Taper Height: 0.00 mm
Concrete Cover: 40.0mm

Lz | 2400.00mm | 5
Ly: | 2400.00mm | §
Square Footing
Pad Footing Eccentricty

Eccentricity X: 0.00mm | 5 aiifl iz
Eccentricity Y 0.00 : EEE
ccentricity Y: omm |3 e g

Design

5ol Stress (Net Bearing Capacity / Maximum Sol Stress)
Reinforcement in %-Dir (13H16 / 200.0) (Provided / Required)
Reinforcement in ¥-Dir (13H16 / 200.0) (Provided / Required)
Punching Check At Column Face (Capacity / Demand)

Funching Check At Distance d from Column (Capacity / Demand)
shear Check At Face of Column X-Dir (Capadity / Demand)

Shear Check At Distance d from Column X-Dir (Capacity / Demand)
Shear Check At Face of Column Y-Dir (Capacity / Demand)

Shear Check At Distance d from Column ¥-Dir (Capacity / Demand)

Design

Column Dimensions

b1
b2:

sss33333%
)

2D Views

sC

250.00>247.60
2010.62>1872.00
2010.52>1872.00
2133.3>1274.2
2133.3>1274.2
453634528
456,42340,9
453.6>452.8
466.4>340.9

3D View

Generate Report oK Cancel
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RC Slab Cross-Sections with Reinforcement Detailing

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

Reinforced slab cross section can be created with reinforcement detailing. In ProtaDetails, cut sections
anywhere along the layout plan drawing and position it anywhere within the drawing sheet.

How to Use

e |n ProtaStructure, ensure that all the slabs reinforcement has been designed using slab strips.
e Go to Concrete Design > Load ProtaDetails
e Generate the Form Plan drawing ensuring options to Show Rebars are checked

Draw Details - Form Plan
W St:0(+0.00m) Options | Options 2
W st: 1 (goumd)
W St: 2(+6.00m, Sim:3) Show Rebars Show Dimensions
M St: 3(+9.00m, Sm:2) W X Top Rebars 1 Pad Footing Dimensions
M st: 4 (roof)
/1 X Bottom Rebars /! strip Footing Dimensions
»/ Y Top Rebars J Slab Hole Dimensions
W Y Bottom Rebars Column Dimensions
Slab Hole / Drop Rebars Shearwall Dimensions
/! Mat Foundation Stand Bar Form Plan Side Dimensions
Draw Similars Separately Hatch Columns\Shearwalls
Display Column Loads
Deselect All

Tip : More slab detailing options are available tin the Options 2 tab.

e Go to Detail Library (top menu) > Pick Plan Sections &3

e Alternatively, in the Command line at the bottom, type “FormSection”
e Inthe Section dialog, input / select the preferred options

e Draw a “section cut” line by clicking on 2 points on the plan view

j } = 5:;—:ir

T section o x
" 2

~ General
Label A
Show Intermediate Elements
Show Level Marks
Show Dimensions
Show Rebars
~ Axes
Show Axes
Show Axes Dimensions
~ Foundation Sections

_:___— 38

N NN NON

Show Excavation Line

N = v Use Single Lean Concrete

T E 1 Excavation Depth (Left) 1200
5 Excavation Depth (Right) 1200
Excavation Clearance 1000
Sol Shave Siope 2

Section A-A

|
| |

e C(lick on the desired location to place the section detail

Tip : Click Lole b (orthogonal) icon right at the bottom to ensure the line is exactly
horizontal/vertical.
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New Rebar Label Settings

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

Rebar label settings has been enhanced to allow for more user-defined options for arrow leaders
(pointing to rebars) and dimensions arrows. This offers greater flexibility for users to produce high
quality drawings to their company standards. This is are accessible to Settings (top menu dropdown) >
Rebar > Rebar Label.

Options l
Rebar Labels Arrow Leader Properties
Envil t
Y S Steel Label Template: nXdsp  ~ ArowEnd Type: | Triangle -~ SIS 37
v N Rebar
General Rebar Group Quantity Seperator: ' x Label Position: iAbo(/e_ iv
B: I::lbar Label Rebar Spacing Seperator: - Arrow End Size: 100.0 mm 2x5014-25-37(A1)
= Lal
Unit and F t Show Rebar Layer Info: W/
q sl 2x5014-25-37(A1)
(7 Scales Slab Rebar Layer Separator:  (
+ A Foundation |
i Retrofit wall
@ Sesomm Definitions Rebar Cirdle Leader
» O Plan Details
+ @ Columns Symbol Sample Label Position: | Above 2d
=1 Bex Details
i o:ptted Berx m B 245014-25-37(A1)
Steel Bar Character: X °
Bar Diameter. d 14 C’/ 4‘ o o (@) (g \PS
Bar Mark ] 37 TSI
Rebar Spacing s 25 oo
Arrow End Type: Triangle ~
Sample
2x5014-25-37(A1)
2x5014-25-37(A1) -

Enhanced Column & Beam Detailing Settings & Drawings

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

Numerous new column and beam detailing options are introduced to enhance the quality of drawings.
For column elevations drawings, longitudinal bars can be lapped in the mid-span of the column
(requirement of some code of practice) & bending of bars (BOB) can be controlled.

These new options are accessible to Settings (top menu dropdown) > Column Settings > Details
Drawings > General tab.

Settings and Parameters
l General || Column Detais | Column Scheduie
Kicker Depth Single Link Type
® —
T
Ifre o C ® [ JO i AR
Column Bars Kicker Depth (Dk): 75 mm imnSL
Mesh Steel Kicker Depth (Dk): 75mm if (11
Foundation Penetration Depth of Links (Dp): omm D, Longitudinal Bar Lap Position -
Starter Bars Length Factor (F): oo P T 1
e | LR TH i
Starter bar length will be calaulated according to code requirements when == =H=
this field is zero. i EE
(RINEE §
Rebar Bob Control i
LAY
o T ( ® F Tmim
—H-
Extend Top Bob Into Beams or  Cut Top Bobs At The Column Face it
Bend Top Bobs Into a U Shape NEuTH
(If No Beams is Available) v Ittt | %
Bottom Bob Factor: 5o -7 ]
Top Bob Factor: 50 ' ik
- i
i
® o I ®
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The beam elevation detail is also enhanced significantly. Cantilever top rebar extension lengths can be
adjusted based on a user-defined factor multiplied by the cantilever length. This feature isimplemented
to cater for some user’s preference for this manner of cantilever beam detailing.

This feature accessible via Settings (top menu dropdown) = Beam Settings = Steel Bars tab.

Settings and Parameters (Storey Beams)

Curtailment | Detailing
SteelBars | SteelBars 2 | Bob Control

Bottom Span Bars Additional Support Bars

Lap Bars Inside Support Extend Support Bars Symmetrically
(@ Lap Bars Outside Support

) Extend by Lap into the Support )
) Extend by Lap into Adjacent Span Add Anchorage Length to Steel Bar Extensions

Rebar Extension Lengths:

\f Merge Similar Bottom Span Bars Inner Support: 0,30 xL
W Merge Similar Top Span Bars External Support: 0.25| xL
| Cantilever Support: 0.25  x L-Cantilever |
LD 251, [ | (0303 J l 03004 L0254 l |
| L1 L2 L3 L4 |

Note : A minimum length of Inner & External support will be applied if the resultant cantilever support
length is less than the former.

The dimension options of lap & extension (or anchorage) are separated for top and bottom bars to cater
for different users’ preference. These options are accessible via the Detailing = Dimensioning tab.

Settings and Parameters (Storey Beams)

Curtaiment | Detailing
General | Beams | Sections | Steel Bars and Links | Side BarsI Dimensioning I

Dimension Options . Anchorage Lengm (Top) | 1000
/! Dimension Steel Bar Lap Lengths (Top) - Lap Length (Top) 2H16
&1 Dimengion Steel Bar Lap Lengths (Bottom) | ‘

& Draw Lap Dimensions Outside Detail - . ]

/] Cimension Steel Bar Anchorage Lengths (Top)
/] Dimension Steel Bar Anchorage Lengths (Battom):

Dimension Support Region Width of Links | LapLength (Bot)
Dimension First and Last Links

Anchorage Length (Bot]

e The column & beam detailing settings are directly inherited from ProtaStructure where the
exact same settings exist.

e Anychanges to the settings in ProtaDetails will only affect new details; existing beam details
remains unchanged.

e Changes in settings in ProtaDetails cannot be saved; it will be discarded when ProtaDetails is
closed.

e |f you want to save changes, please update the same settings in ProtaStructure.
e We strongly recommend you review these settings before producing any drawings.
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Enhanced Precision and Seismic Detailing

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

Slanting Columns and Varying Column Section Sizes

Column elevation detailing is greatly enhanced to include slanting (angled) columns and columns with
varying section sizes. Longitudinal bar detailing including intelligent curtailment and bar cranking
follows Eurocode and ACI recommendations for columns with changing dimensions. Any beams
connected to the columns will be drawn in the elevation as well.
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Ensure to tick “General Column Through Storeys” in Options tab of the Column Elevation dialog box.

Sloping Beams

There is significant enhancement in slanting beam detailing; details are more precise and accurate in
beam elevation drawings.
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Automatic Wall Opening Detailing
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This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

The reinforcement details are automatically created around the shear wall openings in the wall

elevation details. The shear wall openings are displayed in both the sections as well as schedules.
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Geometry

General
Usage

Diameter
Concrete Cover 25
Quantity 2
Multiplier 4
Number Of Replications 1
Spadng 200
Start Kink
End Kink

Layout
Scale Factor 2.50
Barmark

The reinforcement detailing around the opening are only suggested rebars; no actual design is
performed by the program.

The details can easily be amended by selecting any rebar > the Rebar dialog will appear where changes

to size, length & shape can be done.
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Enhanced Retaining Wall Module

This feature was originally introduced in ProtaStructure 2019 but further enhanced in 2020.

The retaining wall module is greatly enhanced and now supports the American ACI318 & ASCE7 code.
In addition, Eurocode is expanded to cover EC2, EC7 and EC8 with all three design approaches. There
are numerous other improvements :

Enhanced Visualization of Loads

Generated loads can be inspected separately for all parts of the wall for long term and short term
analysis. Go to Loads > Select a Load > Selected load will be colored in red.

Retaining Wall
Wall Label | Retaining Wall -1
Tnuts Code | Load Description Total (kNjm)
Geometry ~ Direction: Lateral -
Soi Parameters 101 Active So Lateral Pressure (Static) ]
Analysis Settings Active Soil Lateral Pressure (Dynamic)
Design Settings Lateral Pressure of Water (Static)
Code Settings Active Lateral Pressure of Water (Dynamic)
Active Lateral Pressure of Surcharge (Static)
Andlysls Active Lateral Pressure of Surcharge (Dynamic)
Analysis Summary Stem Self Weight Dynamic Load
Loads Passive Soil Lateral Pressure (Dynamic) 2.50 Vo4
Total Failure Passive Lateral Pressure of Surcharge (Static) 11.19
L11 Passive Lateral Pressure of Surcharge (Dynamic) 0.75 l
Design and Detailing ~ Direction: Vertical M
Design Vo1 Back Fill Weight (Dry) 180.00 ‘
s V02 BackFil Weight (Under Water Table) 16.25 ’ Vi kk lor
Base Plate Vo3 Back Fill Water Weight 16.25 L11L10L08 L01LO2L03 LO4LOS LOB
Vo4 Back Fill Surcharge Load 3.00 V09
Outputs Vo6 Front Fill Surcharge Load 240

Effect of Shelves on Earth Pressure

Effect of shelves on lateral earth pressure and fill weights are now applied and is shown in detailed
loading scheme.

New Methods in Total Failure Check

Two different approaches to total failure are introduced; namely Fellenius and Bishop’s methods. Go
to Total Failure > Analysis Method > Select Fellenius / Bishop’s Method

Multiple Layers of Rebars in Design

New option is introduced to have multiple layers of rebars at base plate. Go to Design Settings >
Number of Top Rebar Layers at Base Plate > Select 1/2/3

Retaining Wall
Inputs Parameters Rebar Selection Parameters
| Use Stem Front Face Splicer Maximum Spading: 200 mm
Geometry
Sol Parameters Use Stem Back Face Splicer Minimum Spadng: 100 mm
Number of Top Rebar Layers at Base Plate: 2 Spacing Step: 10 mm
1
Code Settings Matebals §
Analysis Comoree TR
Analysis Summary Rebar Grade 360 (Type 2) Diameter
Loads Link Grade 460 (Type 2) Diameter
Total Failure
ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Improved Section Design Methodology
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Design approach is changed to be accurately based on reaction/forces at specified sections. Detailed
loadings and design forces at each section can be further inspected . Go to Design > Pick Section

Analysis Detail > Select Position to reveal detail checks.

Inputs

Rebar Descripbon Rebar | Secton Analyss
Geomelry Stem Back Face Yertica Rebar 11100 51
0%
Anlyss Setungs Stem Front Face Vertial Rebar SIAI-120
Desion Settngs Stem Front Face Lateral Dtruton Rebar 34H410-190
Code Settings Base Plate Bottom Rebar 10190
B35 Plte Back Bottom Dstibuton Rebar | 16H410-160
Lot Base Plate Front Bottom Datrbuton Rebey _ 6110-160
T Sose ote Top Rebor ss0-110
e Base Plate Back Top DstrbutonRebar  19H410-190
Total Faire Bsse Plate Front Top DistrbutionRebsr  MH10-140
Chae B 11510
Cesion sndetaling Tisbar 20H10
eson
stem
Base Plate
Outputs
Draning &Report

® Show rebar urmary
O Show section analysis summary

Section Analysis
T Requred/Provided (mmzjm) Positon  DWteNCE Section Depth Losd Conbination, MK VA& (13 Md, frsal = M + Mg =
1209<1327| | Wigram a0 S00_STRIGEO Uit State DA 1Com... 6208 _-100.27 20189 253,
soesel | Ygme g 800 %0 STRIGEOLMtSWeOA TCom... | 0.00 12230 2.9 el
635654 o g} 1300 %0 STR/GEOLmitSwteDA1Com.. 000 19800  -325.33 525,33
Load Load Description Side Factar
Active Sol Lateral Pressure (Static) State Active 135
Active Sol Lateral Pressure (Dynarmic) Dynamic Active 1
Lateral Pressure of Water (Static) State Active 138
Active Lateral Pressure of Water (Dynamic) Oynamic Active 1
Active Latersl Pressure of Surcharge (Stat) State Active LS
Active Lateral Pressure of Surcharge (Dynamic) Dynamic Active. 1
Stem Self Weight Dynamic Load Oamc  Active 1
Passive Sol Lateral Pressure (Static) Statc Passive 1
Passive Sol Lateral Pressure (Dynamic) Dynamc Passive: 1
f: g State Passive 0
Passive Lateral Pressure of Surcharge (Dynamic) Dynamic Passive 1
Self weight Statc Passive: 1.35

Easy Identification and Visualization of Rebars

New Design interface allows easy visual identification of various rebars Go to Design > Pick a Rebar >
the rebar will be highlighted in blue in the diagram.

Retaining Wall
Inputs T T
Rebar Descripton Rebar  Section Analysis  Required/Provided (mm2/jm)
Geometry Stem Back Face Vertical Rebar 61H13-100 s1 1217<1327
Soi Parameters Stem Back Face Lateral Distribution Rebar _ 3410-140 500<561
Analysis Settings | Stem Front Face Vertical Rebar “SIHI0-120 51 525<6&
Design Settings TStem Front Face Lateral Distibution Rebar | 3410-190 S00<561
Code Settings Base Plate Bottom Rebar 44110-190 52853854455 474561
Base Plate Badk Bottom Distribution Rebar  16H10-160 200<491
Anslyss Base Plate Front Bottom Distribution Rebar  8+10-160 0041
Anslysis Summary Base Plate Top Rebar 3IHI0-200 52&S3A544S5 388<393
Loads Base Plate Top Rebar 6IHI3-100 52853454 1223<1327
Total Faiure: Base Plate Back Top Distribution Rebar  19H10-140 500<561
Base Plate Front Top Distribution Rebar  6+H10-160 0041
Design and Detading Chair Bar 115410
o ™~ —
Stem
Base Plate
Outputs
Drawing & Report
(@ Show rebar summary
O Show section analysis summary Section Analysis Detais Redesgn

WallLabel Retaining Wal -1

~

New Detailing interface allows easy visualization and edit of rebars interactively. Go to Stem / Base
Plate > Pick a Reinforcement > Edit number / diameter / spacing

Retaining Wall

44H10-140

Wall Label Retaring Wwal -1

ProtaStructure’

ProtaSteel

ProtaDetails’

ProtaBIM"



ﬁ} DIQOTA Page - 52

New Options in Retaining Wall Stability Checks

New options are introduced to consider the weights of wall stem, base plate, and backfill in dynamic
stability checks. You can access these settings in Analysis Settings > Dynamic Effects of Self Weights

| Indude Hydrodynamic Fressure In the Analysis (Al Calculations)

m Indude Effects of the Water in Tension Cracks (Al Calculations) VE+1
Indude Shelf Effects on the Static Lateral Soil Pressure (Al Calculations) ‘
K
ove rEp AR
W03

Indude (Positive) Effect of the Surcharge Loads in Stability Checks (Overturning, Sliding) LisLzin LOTL02L03 LO4LOS LOG

Indude (Positive) Effect of the Adhesion in Sliding Stability Chedk (Sliding)

Dynamic Effects Of Self Weights
Stem Weight Base Flate Weight Fill Self Weight
Indude to All Caloulations: [} ]| [}
Indude to Overturning And Sliding Calculations: [} ]| [}
ning Safety Sliding Safety g-Max (k Njm2) a-Min (k MNfm2) Total Failure Stability analyses are successful!
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ProtaSteel 2020
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ProtaSteel 2020 redefines whats possible with automated connection design, steel work detailing and

shop drawing production.

New Connection Design Reports

ProtaSteel 2020 introduces additional new connection design with comprehesive check reports to EC3,

AISC (LRFD and ASD) and BS5950 with full code clause referencing including:

e Haunch Connection

e Allbracing and truss connections:
o Bolted Gusset Plate
o Corner Bolted Gusset Plate
o Welded Gusset Plate

o Corner Welded Gusset Plate

e  Purlin/Girt Connections
e Splice Connections
e Apex Haunch Connections
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This adds to the extensive list of designed macros including;

Fin Plate Connection

End Plate Connection

Stiffened End Plate Connection

Flange-Plate Moment Connection

Beam-Column welded connection

Simple Base plate with stiffeners (Stiffeners can be inserted with the “Add Stiffener” option.)

— o g 107155
a wom o a [T b1
1
u
o-0
" e
<<<<< -0 = 011 — PE00
"’ —
boll ‘ \ . T
u1o - ot taege i 310 1501 | 1111 —— 111
Vet sl 04 skasa T \\\
\
; A
HE300A -
i 4 s oo
Saction = IPESO0 Grades S35 Connaction Infe
Bt + 1307 [ Connection Name = Birect Weld
- 531 Tt 1S smwes D= 58
asam = 71mm Design Standard = AISCLIFD
Supported Beam
HE300A
Base Plate 540x8x390 cwo
=H 3
/ 32 s

8812

Anchor Bolts: 2 x M20

Connection Info

MacroD= 1151
Design Standard = AISCLRFD
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New Macro: Wind Column Connection

Wind columns can now be connected to portal frame using Wind Column Connection macro.

New Macro: Beam to Beam Fix Connection

ProtaSteel 2020 introduces another frequently used connection type, especially for continuous beams.
Two continuous beams are connected to the main girder with endplate or stiffened end plate
connection. An additional top plate is used to ensure the moment fixity.

Beam to Beam Fixed Connection Macro Properties for ID : 167

General | Boks | Plates | Macro Preset |

Staggered 1 -

‘ Aoy ‘ Get as Defaul ‘ Farcel ]
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New Macro: Castellated Beams and Beam Openings With Stiffeners

ProtaSteel now supports both castellated steel sections detailing and beam openings and any associated
stiffeners. You can define a circular, hexagonal or rectangular opening or series of openings anywhere
along the beam web. Optional stiffeners with flexible arrangements can be introduced.

Stiffencd Web Opening Macro Properties X
Placements | Geomety | Stifeners | Macro Preset |
Flacement M Stiffened Web Opening Macro Properties x
’75 Epacing  Court  ariable Distances ‘ Plaosments  Gaamety | iifencrs | MacroPreset |
e Shaps

Spacing |500

[~ Exact spacing

Start Offset [800

i3 Apply Set as Default Cancel

New Macro: 2D Fitting Macro

2D Fitting macro creates a cut object from the selected plane to the selected end of a profile. For
detailed information on this macro, please watch https://www.youtube.com/watch?v=YYw7b 1RYPI

b dAPRKRENBYEELEOGE R I AFFET D
2D Fitting Macro
A Functionality :

Creates a cut object from the selected plane to
the selected end of a profile.

@p How to use :
Click the icon, select 3 profile, select a point, P1,
that is the desired corner of the profile, then
salect two points.

@ Hint :
» The third point for the plane is automatically
picked as the cut is always directed in the local
x-direction
» If the first selected point is not a corner of
the profile, then the point is taken as the nearest
corner of the profile.
» A cut object is created for creating the 3D
fitting macro.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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New Macro: Chequered Plate and Grating

Chequered plate and grating can be now created in ProtaSteel. These can be included in material lists
and detail drawings.

fRIHSIFIFTD

Floor Modeller
’ Functionality :
Creates floors made by chequered plates or gratings considering
the connections or profiles that are interfering with the floor polygon.
&p How to use :
Click the icon, select a floor polygon or select beams that form a
polygon or select joints in between beams that form a polygon.

& Hint :
» This macro can automatically decide whether stiffeners are
needed for the given "Area Load".
» To create upward bendings on all edges, check the field
"Upward Bending on Outer Edges".
» To create upward bendings on some of the edges, "Upward
Bending on Outer Edges" field should be grayed (half-checked)
and the field "Bending Switches" should be given in a specific
format (e.g. "0 1 0 0" meaning second edge will be bended and
the others will not be).

New Macro: Automatic Stair Treads

A new macro named Stringer Holes Macro is developed in order to be able to automatically create the
step treads between |, U and C sectioned beams. This macro will open the step holes inside the selected
profiles and create the steps.

Aot H4H4iFSr @
Stringer Holes Macro
AP Functionality :
Creates stringer holes along with stair treads which may be gratings or chequered pl
&p How to use :
Click the icon, select one or two inclined profile (I, U or C).

@ Hint:

¥ If one profile is selected, only stringer holes are created on that profile.
» If two profiles are selected, gratings or chequered plates may be created.
¥ If two profiles are selected, they have to be parallel and be on the same plane.
» If "No Steps" option is selected, "StringerHoles_Defaults.txt" is used to obtain the
dimensions and placements of holes.
> If "Grating" option is selected, "AvailableStepGratings.txt” is used to obtain the
dimensions of the plates and "StringerHoles_Defaults.txt" is used to obtain the
dimensions and placements of holes.
¥ If "Chequered Plate" option is selected, no holes are created, and
"AvailableChequeredPlates.txt" is used to obtain the dimensions of the chequered
plates and these plates are welded to the selected profiles.
¥ "StringerHoles_Defaults.bet”, "AvailableStepGratings.txt" and
"AvailableChequeredPlates.txt" must exist.
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New Macro: Handrail Connection Macro

“Handrail Connection Macro” can be used to automatically weld two neighboring rails.

IR 4 F&ETD

Handrail Connection Macro
A Functionality :
Creates a handrail connection.
& How to use :
Click the icon, select two hand rail.
p Supported Types :
Main: Hand Rail

Secondary: Hand Rail

New IntelliConnect Cases

IntelliConnect is now able to connect joints where:

e Steel beam frames into an RC beam

e Steel beam frames into an RC column

e Truss top chord to column connections

e Truss bottom chord to column connections

e Addition of Simple Base Plate Connection to Column Support IntelliConnect case

Connection Grouping and Numbering

Connections can be grouped and annotated in drawing module.

Placeholder Image

Lorem Ipsum
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Improvement of Weld Drawings (3D Modeling and Hatching of Fillet Welds)

Fillet welds are now modelled as 3D objects in the model and this enables drawing of these welds to be
hatched in shop drawings.

Macro Preset Mapping

ProtaSteel now allows you to create macro presets for any connection or modeling macro using your
favorite settings and company standards.

Creating presets is only half of the job. With ProtaSteel 2020, you can now map your prefered macro
presets to distinct profile types. Creating a custom connection experience where you can dictate yor
connection preferences for any given sections. This powerful feature brings unparalleled productivity in
connection design and standardization. Moreover, Intelliconnect also honors the preset maps you have
specified.

85l Database File Manager - o %

Avaliable Database Files |Haunch Connection Macro Preset Overmide b - Save Discard

File Comments:

Profile MPR_FilgName
HEA3D0 HEA300 mpr
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AutoSave

ProtaSteel 2020 supports an Auto Save option now. By default, model is saved in every 20 minutes and
the auto saved model can be restored next time the user loads the model. Auto Save interval can be
adjusted in General Settings Window (if the interval is set to “0”, Auto Save is disabled).

i General | Lser Inlerface]
Projects Home Directory

|D.\F’rutaSlee|F’rU\Ecls | .

View Up/Down Default Values

Up  [t000 Down {1000

AutoBackup Settings

v Auto Backup px2 only [on save]

M aximum project backup count
AutoSave Settings

Autosave interval in minutes

[ Limit views to open while loading project

ProtaStructure Frame Member End Forces Tables

Internal forces of a frame element for all load combinations obtained from analysis in ProtaStructure is
now displayed in Frame Element Property Editor.

Automated Dimensioning of Axes in General Arrangement Drawings

Floor plans which are automatically transferred from ProtaStructure are now automatically
dimensioned in general arrangement drawings.
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Automated Leaders and Annotation of Connection Details

Typical connection details in general arrangement drawings are now automatically annotated, and a
leader is automatically placed on the view.

Haunch 1

Section Top-Top

3DView1

Section Front-Front

Detail "Left'
Scale: 1/25

End Release Display in General Arrangement Drawings

Members with end releases can now be indicated in general arrangement drawings.

R T i IR

T BT

“I[ Change Profile Drawing

oqlw0z | 1
a
A

1 e e |
1 e e |

ame Property Editor |

Macio Presets

\ =

Load | Save Save s Delete_|

Select Checked Profiles

o

Improvements in Sheet and Drawings Module

Rotation functionality is introduced for Text and TextType2 objects.

Coordinate system option is introduced for Regions

Underline, and leaders are added to Generic Solid label text.

Viewport names can now occupy 2 lines.

Section marker is preserved when Section Symbol object is exploded.

Drawing regions can now be copied.

Weld hatching is optimized according to scale

Drawing collapse feature is improved. Now; collapse gap can be set by the user, and drawing
module objects (as opposed to model objects) can be excluded from collapse.

Created regions were previously placed outside of the paper area. They are now placed
automatically in a suitable position in paper area.

It is now possible to automatically zoom fit to a parent region of a detail or section region via
"Zoom to Parent View" button.

TextWidth factor used in DXF export of drawings can now be adjusted via ini file settings.
Drawing Document creation parameters are now controllable from DrawingModule.ini file.
Several minor bug fixes.
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Bug Fixes and Improvements

During the course of ProtaStructure 2020 development, reported issues inherited from previous
versions are fixed and significant improvements are made.
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Thank You

Thank you for choosing the ProtaStructure Suite product family.

At Prota it is our continual aim to provide you with user-friendly, industry-leading technology for
building design and documentation

Should you have any technical support requests or questions, please do not hesitate to contact us at all
times through globalsupport@ protasoftware.com or asiasupport@ protasoftware.com (Asia Pacific)

Our dedicated online support center together with our responsive technical support team is available
to help you get the most out of Prota’s technology solutions.

The Prota Team
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